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What is a Carbon-Footprint? 
 
Wikipedia defines carbon-footprint as “the total set of GHG (greenhouse gas) emissions caused directly 
and indirectly by an individual, organization, event or product” (UK Carbon Trust 2008). On the web 
you can find carbon-footprint calculators along with suggestions how to lower your personal carbon-
footprint. (For example, http://www.stopglobalwarming.org/ ) In this document we are focusing on 
reducing the carbon-footprint due to printing. 
 

Why bother? 
 
Paper is one source of greenhouse gas emissions (GHG), produced at each step of the manufacturing 
process, including the production and transportation of raw materials as well as the management of 
waste. The use of recycled paper helps substantially. One study of paper cited on PaperSpecs.com 
indicated that “on average, one metric ton of virgin paper in North America produces 4245.1 kg 
equivalent of CO2, while the same ton of 100 percent recycled paper produces 1791.1 kg.”  
 
Using recycled paper is a big help, but what we really need to do is go on a “paper-diet”. The web is 
full of sites encouraging us to decrease our consumption of paper. Check out shrinkpaper.org for 
one. 
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Here are some vital statistics from greenprint.com that should motivate you to stop printing so 
much. 
 

• 35% of the worldwide wood harvest ends up as paper 
• The United States threw out 20% of all the paper made in the world 
• One fifth of all the tropical rainforests in the world disappeared between 1960 and 1990 
• Europe and America have less than one-half of their original forest cover 
• It takes about 31 million BTU’s to make a ton of paper enough energy to power a U.S. home 

for 2 months 
 
Ink is also a source of green-house emissions so along with using less paper, we want to use less 
ink.  

WDRS and Paper and Ink 
 
WDRS has already made considerable progress in trying to cut down on paper use.  Some examples of 
these efforts are: 
 

• New hire orientation – materials online 
• Job announcements – online 
• Benefits – plan descriptions, forms online 
• The use of double-sided printers 
• Recycling paper 

 
Nevertheless we still print and copy lots of documents.  
 

Are hardcopies required? 
 
Each time you print to hardcopy, ask yourself if you really need a paper copy of this document. Try to 
get used to reading documents on the web. Provide your colleagues with electronic documents instead of 
printed ones. If you are teaching a class, consider delivering the materials for the class online or on a CD 
or DVD. 
 
 If you have problems reading a document on the computer screen, make sure you have a good 
prescription for your eye glasses.  Also remember that you can always pump up the size of the font. For 
example, in MsWord, select Zoom under the View Menu and set the zoom value. 
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Use the radio buttons or fill in a percent. 

Here the Zoom is set to 125%. 

 
In Safari and most browsers, you can change the font size: 

 
 
Those of you who are used to reading from books and papers may find it difficult to make the transition 
to reading documents on a screen. At least give it a try.  If you are proofreading a document, rather than 
marking up a page, maybe you should be making the changes directly to the document with tracking 
turned on as shown here for MsWord. 
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Your markup actually gets the job done rather than taking a two-step process of marking up on paper 
and then putting the changes in the electronic document. 
 

If You Have to Print 
 
If you have to print, we provide techniques that might help cut down on the number of pages and the 
amount of ink you use. 
 
The screen shots provided are for Mac users and many of the printing examples are from MsWord. They 
assume a particular printer setup, but they should serve to give an idea where to change settings on any 
printer. 
 

Setting up Your Printer Correctly 
When setting up your printer in MacOSX, you are better off selecting the printer driver associated with 
your printer rather than using the generic printer. Look for the company and model number when 
choosing the driver. This way you can take advantage of the special capabilities of your printer.  
Education Office staff can ask Waylon for help with this. 
 

Printing Duplex  
Most printers support the ability to print duplex, on both sides.  When you go to print, you should see a 
dialog box. If it is printing on one side, you will see something like this with Presets set to Standard. 
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Look for Duplex in the Presets pull-down menu.  If it is there, select it.  If it isn’t, then your printer may 
not support double-sided printing or perhaps you have a generic printer driver that does not recognize 
your printer’s full capabilities.  If you succeed, your dialog box should have: 
 

 
 
Already this can cut the number of pages you print in half!  If the printer you use most fequently does 
not support duplex printing, either find a printer that does or ask your system administrator whether they 
can purchase a duplex unit for the printer.  Waylon Meadors indicated that there are some printers the 
Education Office staff use that could be upgraded. 
 

Printing Multiple Pages per Sheet: 
This is particularly relevant when you are printing out handouts for meetings. To avoid this altogether, 
you might consider putting your talk on a server for people to download or access directly from their 
computers when they come to the meeting.  It really depends on whether the people to whom you are 
talking bring a computer to talks and whether they need a hardcopy to make notes on.  If your audience 
requires hardcopies, then print at least two per sheet and make them double-side. 
 
To see this capability, you are going to need to click on the downward arrow to the right of the Printer 
selection pull-down.  It will point up when you display the longer dialog box.  
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Next select Layout from the pull-down list where you see Copies & Pages. 
 

 
 
Check the number of pages per sheet to 2 or even higher if you think you can read the material that 
small. 
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You can play with the other settings, but the defaults are a good start.  You can also click Preview to see 
how it looks. 
 

Printing Preview  
Sometimes all you really want to do is to see how your document looks - Print Preview. Often you want 
to see how a table or graph is lining up and you don’t need to print to paper.   You can do some of the 
early proofreading by looking at a preview.  It may be that you really don’t need to print your document 
to the printer until you have the final version. You can Print Preview from the File Menu or from the 
Printer dialog box.  Be sure you choose the printer on which you plan to print the final copy if you need 
it to be a hardcopy.  Different printers behave in a different manner. 
 
Also available in some print dialog box is a Quick Preview that allows you to click through the pages 
and see how each lays out on the page.  This may be sufficient when you are trying to get rid of white 
space. 
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Printing Only the Pages You Need  
Often we only need one part of a document..  Don’t print the whole document!  Just choose those pages. 
Enter the page numbers and click the From: radio button or a page range. 
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Printing to PDF  
Sometimes we don’t really need to print the document to hardcopy, but we want an electronic version.  
It is an easy way to make an Operating-System-independent document that we can send to our 
colleagues or put on the web.  It is useful also for web pages and email messages that we want to be able 
to look at later and may not remember the URL or may have deleted the original email.  Simply choose 
the PDF button at the bottom, give the file a good name and save it in a place where you can find it.  
Here we are looking at the Education Webserver and printing it to PDF. 
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Notice you have a lot of choices here.  You can also email it.  In this example, we’ll save it to a folder 
where we keep examples of websites.  I might want to give it a shorter name, but right not it uses the 
name in the title of the document.  Just click SAVE. 
 

 

Print Cover Page (turned off) 
Most of us have this turned off, but maybe you don’t.  In an office with lots of people, including a print 
cover page makes it easy to keep track of your work, but it eats up a lot of paper.  Title your documents 
so it is obvious they are yours. If you are printing another person’s document, this may not be so easy. If 
you are printing one-page documents, you are often doubling the paper consumption each time your 
print.  On a Mac, to turn off printing the cover sheet, choose Cover Page from the third pull-down menu 
and click the radio button labeled “None”. 
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Saving commonly-used options 
Once you have all your settings the way you want them, you save them to a preset file that you can use 
over and over instead of having to set each again.  For instance if I have set printing to Duplex and 2 
sheets per paper, I select Save As in the Preset pull-down. 

 
 
I give the preset a name, in this case Duplex-2. 
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Now when I want to print with 2 pages per sheet duplex, I can select this preset. 
 

 

 

Formatting Your Document 
You can set the margins, font size, etc. in your document to cover more of the page and be denser.  You 
also can resize images so there are not big gaps in your document because your image won’t fit on the 
remaining part of the page. In a document like this one with lots of screen grabs, it is hard to avoid too 
much white space where the picture you insert doesn’t fit on the same page as the text and therefore is 
placed on the next page. In the case of this document, we are hoping that you will never print it out, but 
instead you will open it on your computer and use it from there. 
 
Here are some recommendations from the web site Reach for Unbleached Foundation 
http://www.rfu.org/cp/saving.html 
 

“The good news is that you can easily tweak a few of the default settings in Microsoft Word to make 
your documents print more efficiently and use quite a bit less paper. While you might not want to do 
this for "formal" documents, making these tweaks can help you save a lot of paper when working 
with "draft" documents or documents that are purely for internal use. 
These tips were adapted from an article in Office Watch, one of our favourite sources of information 
on all things Microsoft Office. 
Three simple Word formatting tweaks to help you save paper: 

1. Word's default margin settings are an inch at the top and bottom and 1.25 inches on the 
sides. Change them all to .9 of an inch. You've just increased the printable area on your 
page, and your document will become about 10% shorter. 

2. The default font size is 12 point. You can change it 11.5 point to shrink your document 
about 5%. 

3. The line spacing is single spacing by default. If you change it to .95, you gain an extra line 
every 20 lines, and make your document 5% shorter. 

How do you do make these changes? While Word has lots of ways to change specific settings, if you 
want to make all of these changes at once, nothing beats working on the default template directly.” 
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On a Mac, changing the default settings involves using the Format Menu and saving any changes as 
your default. First select Document from the Format Menu. 
 

 
 
Click the Margins tab, and then set the margins to .9. After you set the new margins, click Default to 
have MsWord save the new default settings in the template on which the document is based. Each new 
document based on that template will automatically use the new margin settings. 

 
 
You will get a dialog box asking if you want to save the default settings. Click Yes. 
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Second select Font from the Format Menu. Set the Size to 11.5 and click Default. 

 

 
 
 
Again you will get the dialog box to save the new default settings as shown before. The default font 
applies to new documents based on the active template. Different templates might use different default 
font settings. 
 
Line spacing determines the amount of vertical space between lines of text. Microsoft Word uses single 
line spacing by default. The line spacing you select will affect all lines of text in the selected paragraph 
or the paragraph that contains the insertion point. You can set line spacing on the Indents and Spacing 
tab (Format menu, Paragraph command). The default of single line spacing is a big improvement over 
1.5 lines and double spacing so you may not need to worry about this. On the Mac, it is a little confusing 
where to change this. 

Using GreenPrint 
There is a cute little application for Windows and Mac OSX Leopard that allows you to control the 
pages you print and whether you print graphics and/or text.  It keeps a log of how much you have saved 
in paper and cost by eliminating printing blank pages and unwanted images.  There is a free trial version 
to test and it may actually be enough to use the 30-day free copy to train you into better habits.  There is 
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a free version that does not have all the functionality of the $29 version, but it does provide the main 
benefits. Look at  
 
http://printgreener.com/ 
 
Ask your system administrator if have problems installing it.  It does require some overhead in the time 
it takes to analyze the print job and for you to delete pages or content.  You may decide that you want to 
concentrate on other techniques to cut down on your printing. 
 

Print to Draft 
With some printers, you can change the Image Quality.  This saves toner. For example with the printer 
used for these test, you can choose Image Quality and set it the HPEconoMode to Save Toner.  These 
features depend on the printer you have. 

 

Eco Font 
You can use a font that does not use as much ink as other fonts.  This is accomplished by making tiny 
dots throughout the solid part of the character.  The human eye does not notice them. 
 
http://www.ecofont.eu/look_at_ecofont_en.html 

Paperless Office 
The applications on your computer provide lots of ways to keep important documents.  There is lots of 
online help available to take advantage of this functionality.  Here are a few ideas. 
 

Managing E-mail 
 
Save your e-mail into folders either manually or defining rules for storing them.  Even if you do not save 
them into folders, most e-mail programs allow sorting by the sender, by topic, date, etc. and also 
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searching in each of these categories.  You should not have to print out important email because it 
remains in your e-mail system unless you set it to delete automatically.  If an email is especailly 
important, you can also print it to a pdf file and store that in a folder where you can access it easily. By 
the way, one way to remind your correspondents that they might not want to print the mail you send 
them is to append a message to your signature.  For example, Liz Quigg has this signature. 
 
------------------------ 
Liz Quigg 
Fermilab 
MS 226, Box 500 
Batavia, IL 60510 
630 840-2631 
liz@fnal.gov 
 
"Save a tree; think twice about printing this e-mail." 
 
 

Electronic Notes 
 
Mac operating systems have Stickies that allow you make all sorts of notes.  You don’t have to be 
scratching these on a piece of paper.  You can even search through these. You can put them on your doc 
for easy access. 
 

Electronic Calendars 
 
Electronic calendars allow you to keep track of your life and send you emails or alarms to remind you of 
important meetings.  They have more functionality than a little note book. You can keep a “to do” list 
with due dates along with your calendar items. If you have a PDA such as a iPod or iPhone, you can 
synch the information between the computer and device and have access to you calendar and contacts on 
both. 
 

Scanning and Emailing Documents from Copiers 
 
Many copiers allow you to scan a document and e-mail it to a list of people.  For example, if you are 
given a hardcopy of a document you want to save for yourself or share with others, you can use the 
copier machine (WH15W_XEROX275) in the 15th Floor Southeast corner to email an electronic 
version of this document to yourself and others.  You don’t have to keep the original anymore. When 
you receive the email with the the resultant pdf file attached, you can save it to a folder on your 
computer. You can scan in as many pages as you want at a time just as you do when you copy 
documents. The full instructions for this are available on the web from the manual. It supports various 
quality of scans including those that can be used by OCR (Optical Character Recognition) programs to 
extract the text.   
 
If you have a copier that indicates it supports this functionality, but you cannot get it to work, make out 
a helpdesk ticket and the Computing Division should be able to help you. 
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April 14th Update: 
 
Other ideas 
Print selection instead of a whole document 
Copying and pasting text from web pages into a Word document and printing that. 
Reusing paper printed on one side as note paper. 
Print B&W 
Browsers – print pages without backgrounds to save ink 
 
 
 
 
 


